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Working with Pictures

A General Picture Handling

10.1 Importing Pictures. . . ... .. .
10.2 Selecting Pictures. . ... .. e
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10.4 Resizing PICtUIES . ... ...
10.5 Rotating Pictures. . ........... ... . .
10.6  Cropping Pictures .. . .......... .
10.7  Modify Picture. . ... e
10.8 Optionsonthe EditMenu............... .. .. ... . .......
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B Large Picture Support

10.10 Importing pictures . . . ...t
10.11 Setting Picturechoices. . ........... .. .. .. .. i
10.12 Referenced Picturesand MailMerge . . ...................
10.13 Snags, Hintsand TipS. . .. ... ..ot

This chapter describes how to import pictures into frames, and then
manipulate them in various ways.

The handling of large and/or high resolution pictures or complicated
vector files is mentioned separately in the second part of this chapter
starting with an introduction to this aspect of picture handling.
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10.1 Importing Pictures The imported picture is centred and scaled to fit
To import a picture, drag the picture file into a inside the frame but keeping its original aspect

frame. You may import standard Windows bitmaﬂ'atio .. its original shape. If the frame is

(.bmp), JPEG, RISC OS Sprite and Draw files rectangular, the entire picture will be visible
plus other popular formats detailed in the (figs. 10.1 and 10.2), otherwise the edges of the

Ovation Pro release notes. If you try and load an pi_cture are cropped to suit the shape of the frame
unrecognised picture format, the file will be (figs.10.3 and 10.4).

interpreted as a text file and you will be asked to Menuc>Filec>lmport...

confirm whether you wish to proceed loading it Aq an alternative to drag and drop you can use this
(see 3.3). menu entry to open a standard Windows open file
A warning is given if there is insufficient memory window and select the picture file you want.

to load the picture.

The frame may be any shape, but must be
completely empty or already contain a picture (in
which case the old picture is overwritten). You
cannot import a picture into a frame that already
contains text unless all the text is deleted first,
otherwise the picture is embedded in the text (see
later).

Fig. 10.1 - Fit to frame with aspect lock. Fig. 10.3 - Fit picture in elliptical frame.

Fig. 10.2 - Fit to frame with aspect lock. Fig. 10.4 - Fit picture in irregular frame.
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Importing at a Specified Scale

If you hold down Ctrl when importing a picture,
the picture is imported at the scale specified in
Choices(see 14.7). By default this is 100% i.e.
the original picture size.

Embedding a Picture
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10.2 Selecting Pictures

If a picture hasn’t been selected, operations suct
as move, rotate, cut, copy etc. apply to the
selected frame and its contents. If the picture ha:
been selected, these operations apply to the
picture only; the frame remains unchanged.

If you drag a picture into a text frame which is notChoose the Select tool on the toolbox and left

empty, the picture is imported into an
automatically generated picture frame which is
embedded into the text at the pointer position.

The picture is imported at its original scale, but
scaled down to fit if necessary.

Saving Pictures

If there is an active picture frame, the

Save pictureoption becomes available on thige
menu. This allows you to save the picture in the
frame to disc, or to another application. The
picture is saved in the same format that it was
loaded in.

. 10.5 - A selected picture.

double-click on a picture to select it. A three-
pronged resize tool is displayed over the centre «
the picture confirming that it is selectéah. 10.5).

Right click over a selected picture to deselect it.
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10.3 Moving Pictures Using the Info Palette

To move a picture within a frame, ensure that theYou may use the info paletfgg. 10.7) to position
Select tool is active then double-click over the  the picture in the selected frame (in this case the
picture to select it. Now left click and hold over picture does not need to be select&dandY are
the picture (not over a handle) and when the Hanthe offsets from the top left corner of the frame to

tool appeargfig. 10.6) you can move the picture. the top left corner of the picture, and can be
modified to change the position of the picture.

You can constrain movement to the vertical or Press Return afterwards to update the document.

horizontal direction by holding down Shift before ' '
dragging and keeping it held down while moving Alternatively, click on the up and down buttons to

the picture. move the picture in the appropriate direction.
You can position the picture within the frame Note that theX andY fields towards the left side
precisely using the info palette or thi®dify of the info palette refer to the picture frame,
picture dialogue boxsee 10.7). F6  WhereaX andY towards the right edge refer to

the picture itself.

Fig. 10.6 - Use the hand tool to drag
the picture to a new position.

Picture frarme ¥ 9mm iy | 49.95mm Seale | 20 ﬂ}{ Umm jAI a j
1132 ¥ 187 87mre H[4967mm Aspect| 100 :II ¥ Ornm :II Fitl Ctr

Fig. 10.7 - The info palette gives the position of the current picture. You can reposition it by changing the X and Y values. The
info seen here reflects details of Fig. 10.6
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10.4 Resizing Pictures Aspectis the ratio of the horizontal scale of the
Menu=PicturessModify picture... F6 picture to the vertical. You can enter a new value

_ ) _orclick on the up and down icons to change the
To resize a picture, ensure that the Select tool is aspect one percent at a time. A value of 100%

active then double-click over the picture to select ,aans that the picture is displayed in its original

it (fig. 10.8). To resize the picture, drag the handleghape. To stretch a picture sideways increase th

at the end of the diagonal line on the resize value, and to squash a picture sideways decreas
gadget. liAspect lockis selected on thilodify this value. For example, to make a picture twice

picture dialogue box, the picture shape willbe  \yiqe as its original, set Aspect to 200%.

retained. . :
Resizing Frame & Picture

If you resize a picture frame by dragging its
handle using the right mouse button, the picture
resized too. WittAspect lockset the picture will
Be resized to fit the height of the frame. Otherwis

You can resize the picture precisely by using the the picture will follow the size of the frame.
info palette or théodify picture dialogue box

To resize the picture in the horizontal direction

only, drag the handle at the end of the horizontal
line. To resize the picture in the vertical direction
only, drag the handle at the end of the vertical lin

Fit
(see 10.7). . _ . e
) This option scales the picture so that it fits the
Using the Info Palette frame. If theAspect lockoption on the

You may use the info paletfBg. 10.9) to resize  Modify picture dialogue box is selected, the
the picture in the selected frame (in this case the picture shape will remain unchanged. If

picture does not need to be selected). Aspect lockis not selected, the picture may be
Scaleis the scale of the current picture as a stretched to fit the frame exaCtly. Ctrl+J can be

percentage of its original size. You can enter a  used as a short cut.
new value or click on the up and down iconsto Ctr

change the scale one percent at a time. Changingrp,;g option will centre the picture without

this value affects scaling in both X and Y changing its scale. It is especially useful if due tc
direction, so the picture shape is not changed. rescaling the picture has moved out of sight.

Ctrl+E can be ued as a short cut.

Fig. 10.8 - Double click on the picture to select it
instead of the frame.
Drag the handles to scale the picture.

Picture frame w| Immo | 43.55mm - Segle | 90 ill}{ Ornm :II“E‘I 0 :II
1132 v[18757mn W[ 4967mm Aspect| 100 = ¥[ Omm = Fit | cur]

Fig. 10.9 - The info palette allows the scale and aspect ratio of the picture in the selected
frame to be altered. The Fit option, fits the picture to the frame..
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10.5 Rotating Pictures Using the Info Palette

Whenever a picture frame is active, A on the info When a picture is selected and the Rotate tool
palette(fig. 10.9) shows the angle of rotation for chosen, the options on the info paléftg. 10.12)
the picture. The angle is in degrees and is apply to the rotation of the picture instead of the
measured anti-clockwise. You may enter a new Object.

value and press Return or click on the up and A s the angle of rotation of the picture. The angle
down icons to increase or decrease the angle by of rotation is in degrees and is measured anti-

one degree or by ten degrees while holding downc|ockwise. You may type in a new value followed
Shift. The picture is rotated about the centre of thgy Return to rotate the picture to the desired

frame. angle. Alternatively click on the up and down
To set an exact angle use the Angle dialogue boXcons to increase or decrease the angle by one
on theModify picture menu degree.

Menu=>PicturesoModify picture... F6 Clicking on the 3 x 3 grid will position the

Using the Rotate Tool crosshair at the same relative position on the
9 frame containing the picture. The 9 points relate to

Ensure that the Select tool is active then double- yo centre, the fours corners and the centres of the
click over the picture to select it. Now choose the¢, ¢ sides.

Rotate toolfig. 10.10) then left click and drag on o _ )
any part of the picture until it is at the required If Crosshairis selgcted, the_plc_tu_re is rotated
angle(fig. 10.11). about the crosshair, otherwise it is rotated about

_ _ o its centre.
The centre of rotation for the picture is indicated

by a small crosshair, which can be dragged toa  RRotating is not possible when a picture has
new position if required. been locked.

I = |

<

—— Rotate tool

:9\
I~ The crosshair
[ = /._'I

Fig. 10.11 - When a picture is selected you may use the rotate tool to rotate the picture
about the centre of rotation indicated by the crosshair.
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Fig. 10.10 - The Rotate tool.

Ratate AE jJJJpCfDSShaif g | oo° | 1800 | -on°
Frr
11 rrr 452 | 1350 | -135°] -45°

Fig. 10.12 - When a picture is selected and the Rotate tool chosen, the info palette
provides options concerned with rotating the picture.
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10.6 Cropping Pictures It is important to remember that the Crop tool only
results in a changed view within the picture frame.
But the original picture is not changed in any way,
as can be seen by resizing the picture frame.

The Crop toolfig. 10.13) allows you to crop or
cut off unwanted edges of a picture leaving the
part you do want filling the frame.

Position the pointer at the top left corner of the
rectangle you want to retain and drag to the
bottom right corne(fig. 10.14). When you release

the mouse button the part of the picture you haveThe Crop Info palette gives information while

chosen is ‘fitted’ into the fram@@ig. 10.15) as cropping a picture frame. It does not allow you to
follows: set dimensions.
» If Aspect lockon theModify picture To reset, select the picture using the Select tool

dialogue box is selectddee 10.7), the picture and then click Fit on the Picture Info palette.

is scaled to fit the frame without changing
shape.

» If Aspect lockis not selected, the picture is
scaled to fit the frame precisely, changing its
shape is necessary.

You can’t crop a picture if it has been locked.

Cropping can actually be done by dragging from
any corner to the opposite diagonal corner. When
using the Crop tool, you must start within the
picture frame. You can eventually drag beyond
the picture frame, resulting in a scaling down of
the cropped picture.

—— Crop tool

) OIOE8 o

I2|<|(

Fig. 10.13 - The Crop tool.

CropprING PicTurES

This also means that by selecting the picture (by
double clicking on it) one can move the picture to
reposition it within the frame.

Fig. 10.15 - The cropped picture.
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10.7 Modify Picture Tile
Menur>Picturer>Modify picture... F6 This allows the picture in a frame to be repeated

TheModify picture dialogue boxfig. 10.16 & ona rectangulqr grid. The andY.dlsFance icons
. . . ; are the separation between copies in the frame of
fig. 10.17) is available from the main menu when

4 picture frame is active reference of the original picture. So for example if
P _ ' _ o the distance is 10mm and the scale the picture is
It can also be displayed by triple-clicking over a rendered at is 50% the distance you see will be

picture. 5mm(fig.10.18).
Scale Perfect joins between copies of pictures may not
This is the scale of the current picture as a be possible. If you get slivers of frame

percentage of its original size. You can enter a  background showing through, try a small negative
new value or click on the up and down icons to value for the distances.

change the scale one percent at a time. Changing

this value affects scaling in both X and Y

direction, so the picture shape is not changed.

Aspect

This is the horizontal scaling of the picture. You
can enter a new value or click on the up and down
icons to change the aspect one percent at a time. A
value of 100% means that the picture is displayed
at its original shape. To stretch a picture sideways
increase this value, and to squash a picture
sideways decrease this value. For example, to

make a picture twice as wide as its original, set Tile X
Aspectto 200%. -0 0 88 8 8 8 8 8

This is the angle of rotation of the picture in the AdL00a000d

frame. You can enter a new value or click on the

up and down icons to change the angle one degree AdAd00840000

at a t.ime- The ?n9|e i? SpeCi.ﬁed in d.egreeS, and ¢Fig, 10.18 - A tiled bitmap image, size 34x17 pixels with
positive angle is applied anti-clockwise. settings: Scale 50%, Aspect 100%, Tile X=5mm Y=7mm

T Modify picture |

Scale| 90 % w|a] x| Odmm v | 4]
Aspect| 100 % =|a| v| Omm =]
Angle| U © | |’ ™ Tile

Skew_ﬂ . LILI }{I Ormirm ‘fl Ormrmn

& Po lock = Centre lock ¢ Lock

Modify picture... F& V¥ Aspect lock [ Auto scale ™ Hide picture
Info.. [T ¥ &Y from bottarn left
Reference...
Fi

oy Fit Apply Cancel oK
Frocess...
SCreet...

Fig. 10.17 - The Modify picture box provides options for altering the
Fig. 10.16 - The Picture menu. properties of pictures.. Values as used for fig. 10.18.
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X, Y

Mobiry Picture 137

Aspect Lock

These show the offsets from the top left corner oflf Aspect lock is selected, the Auto scale, Fit and
the frame to the top left corner of the picture. Youcrop options will scale the picture to fit the frame
can enter a new value or click on the up and dowretaining its original shape. If Aspect lock is not

icons.

X and Y from bottom left

When this is selected théandY coordinates will
show the offset of the origin of the pictures
internal space from the bottom left corner of the
picture frame.

Skew

selected, the Auto scale, Fit and crop options wil
stretch the picture to fit the frame precisely.

The diagonal scale gadget is also affected by thi
option.
Auto scale

If Auto scale is selected, then re-sizing a picture
frame with Select causes the picture to be re-siz

This is the angle of skew for the picture. You cant00. This normally only happens if you re-size a

enter a new value or click on the up and down

picture frame with the right mouse button.

icons to change the angle of skew one degree at gide picture

time. A positive value skews the picture to the
right (fig. 10.19) and a negative value, to the left

If Hide picture is selected, the picture in the fram
is hidden and replaced by a cross. this may be

(fig. 10.19). The angle is specified in degrees and,qqf,| if the picture is slow to redraw.

must be within the range -80° to 80°.

No Lock
No lock is the default setting and allows the

picture to be moved, resized or rotated from the

dialogue box, info palette or by dragging.
Centre Lock

If Centre lock is selected, the picture is locked to

the centre of the frame. The X and Y values

cannot be changed, nor can the picture be moved

from the info palette or by dragging.
Lock

This option locks the picture so that it cannot be
moved, resized or rotated from the info palette or

by dragging.

Fig. 10.19 - Picture skewed 25°

Fig. 10.20 - Picture skewed -25°
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10.8 Options on the Edit Menu Delete picture Ctrl+K
Menu=>Edite> This option deletes the selected picture.

TheEdit menu(fig. 10.21) contains a number of  Select all Ctrl+A

operations that you can apply to a selected picturgyhen one object has been sele@etect all

If you do not have a selected picture, the results in all frames on the present page being

operations on this menu will apply to the frame. gglected.

To select a picture double-click on it so that the Clear Ctrl+Z
resize gadget is displayég. 10.22). Right click
to deselect a picture.

Cut picture Ctrl+X

Cut deletes the selected picture and places it on
the clipboard. The previous contents of the
clipboard are overwritten by this operation.

Clear deselects the selected picture(s).

Copy picture Ctrl+C

Copy copies the selected picture onto the
clipboard. The previous contents of the clipboard
are overwritten by this operation.

Paste picture Ctrl+Vv

Pasteinserts the picture that is on the clipboard,
into the active picture frame. A picture can be
pasted into an@vation Pro document, not just

the one from which it was cut or copied. After
pasting, the clipboard contents remain unchanged.
This option is only available if the clipboard
contains a picture and there is a picture frame or
empty frame active.

Undo Deselect  Citl+Z

Beda 7 [
Cut Picture Cirl+
Copy Fictura Cirl+
Paste clipboard  Cirl+
Delete Ficture Cirl+k
Ermbed aliject

select all i+,
Clear

Eitidl... Etl+E
il e =3

Fig. 10.21 - The Edit menu. Fig. 10.22 - A selected picture.
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Drag & Drop Pictures and memory use

Instead of usin@ut, Copy andPasteto move or  If you copy a picture or picture frame within the
copy a picture via the clipboard, you can use the same document using ‘drag and drop’, the

drag and drop facility to do this directly. resulting copy is simply a pointer (or reference) t
the original and uses no extra memory. Howevel
if you ‘drag and drop’ to another document, an
entirely separate copy is made in the destination
document.

To use drag and drop, first select the picture you
wish to move or copy. Now press Alt and left
click over the picture so that the drag and drop
tool is displayed. Then drag until the pointer is
over the required frame and release the mouse The same is true when pictures or picture frames
button to insert the picture. The destination frameare copied usinGopy andPastevia the

must be empty or contain a picture (in which caseclipboard. However, since the clipboard is treate:
the original picture is overwritten). as a separate document, a separate copy is kepr
the clipboard until it is overwritten by another
object. For example, if you import a 100K picture
copy it to the clipboard and then paste it back 6

_ ] ) times, only 200K or RAM will be used (100K in

If you hold down Shift Alt while dragging, the  he document and 100K on the clipboard). When
above operations are transposed. So, if you drag gnother object is copied to the clipboard, causing

and drop within the same document, the picture igp picture to be overwritten, the resulting RAM
copied; if you drag and drop to another document, ,caq will be only 100K.

the picture isnoved.

If you drag and drop within the same document,
the picture isnoved; if you drag and drop to
another document, the picturecpied.

If you start a drag operation and wish to cancel it,
press Esc.
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10.9 Object Linking & Embedding (OLE)

Windows OLE, sometimes known as COM or
Active X is not currently supported. See the
Ovation Pro release notes for news of
developments.

CHapTER 10
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Large Picture Support

Ovation Pro provides some facilities for handling large pictures. These are
referenced pictures and proxy pictures.

Normally pictures are embedded in Ovation Pro documents. So for example a
document containing five 20Mb pictures will be at least 100Mb in size. A
referenced picture on the other hand is not embedded in a document. Instead
the document contains the filename/path of the picture (the reference) and the
picture is stored on disc separate from the document.

Typically referenced pictures will be used by those producing documents
including high resolution pictures for professional printing. By keeping the
pictures separate from the document it becomes easier to modify because it
uses less memory. In addition referenced pictures are only loaded when needed,
this is a simple form of virtual memory.

There are a couple of other situations in which referenced pictures are useful.
Firstly if you have a large number of documents which contain the same picture.
The classic example is a logo used on a letterhead. By making this a referenced
picture there can be a substantial overall saving in disc space.

The other possibility opened by referenced pictures is mail merging where the
pictures in the merged documents change depending on the data used.
Traditional mail merge allows you to personalise documents by inserting
someone's name and address, now you can also include their picture.

A proxy picture is a small fast to render picture which is used in place of a large
or slow to render picture whilst the document is edited. The standard use of
proxy pictures is in conjunction with large referenced pictures. The referenced
picture is only ever loaded into memory when the document is printed, the rest of
the time the proxy is used. Another less common use is for pictures that are slow
to render e.g. complex vector pictures.

On the following pages you can find information on:

Importing Pictures . . . ... . 142
Setting Picture choices .. ........ ... 145
Referenced Pictures and Mail Merge. . . ............. ... 146

Snags, Hintsand Tips .. ........ ... . . 147

141
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10.10 Importing Pictures

If Shift is held down when a picture is drag and
dropped into a frame, a new dialogue box will
appearfig.10.23).

Proxy

The two button®roxy andReferencecontrol if

the imported picture will have a proxy generated

for it and if it will be referenced. A referenced
picture must exist on disc, you can't drag the

picture from another application. The menu icon

to the far right of théroxy button allows you to

open another window to set the parameters for thgontrol the Proxy and Reference aspects from two
proxy imageg(fig.10.24).

Proxy image, size

The buttons on the left control tkige of the
proxy. If for example the source picture is 2

CHapTER 10

Proxy image, colour depth

The group of buttons on the right set togour
depth for the proxy. Normally you will use scaling
and colour depth so that the proxy picture is
smaller than the original picture, i.e. it is scaled
down and has a lower colour depth.

Dithering
TheDithering button controls if dithering will be

used when making the proxy picture in low colour
depths.

Once a picture is imported it is still possible to

new entries which appear on tRAeture menu,
accessible from the main menu when a picture
frame is selecte(fig. 22.25).

Menuc>Picturem........

inches square, then selecting base/2 will generate
a proxy picture 1 inch square. Assuming the same
resolution the proxy picture would have (1/2) *
(1/2) i.e. (1/4) the number of pixels.

Epictureimpot K|

Ficture I CAMyJunkilmstuffiTestvAdBug. spr

™ Proxy IEiaSEM Bbpp EI

[T Reference

Cancel | ]2

Fig, 10.23 - This window appears when a picture is dragged and
dropped into a frame if the Shift key is held down.

T Proxy picture |

—Size — Colour Depth
" Baseff 1 Base C dbpp 16 bpp

i Basefd  Base™? & Bbpp 32 bpp
" Basefd 1 Base™

I+ Dithering
Current praxy sizel 0 Ficture sizel 3l
Remove praxy picture | Remove all proxy pictures |

Cancel | Make proxy picture

Fig, 10.24 - The window to set the Proxy parameters.

kadity picture... FB
Info...

Feference...
Froxy...

Frocess..

SCreen...

Fig, 10.25 - The Picture menu
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Reference... Collect referenced picturesallows you to create
Menu=Picture=>Reference... a directory, into which all the referenced pictures
in the document will be copied from their current

SelectingReference...will open the dialogue box locations. This a way of gathering all the pictures

showing the location of the referenced pictirg for a document in one place before sending the

10.26) | _ document and pictures for printing. When the
The top icon shows théath to the current picture Picture Reference box is first opened the path
and can be edited to change the picture pointed tghown is in position independent form - which
You can drop a file into this icon to set up a path means it makes use of tffdedir} macro (just

or click on the button to the right to browse for a described). If you simply click o@ollect

file. TheReference Picturebutton will set the referenced pictures this sort of path will be used
path, loading the picture if necessary. This is alsofor the collected pictures. So you can

a way of replacing a picture with a referenced ongubsequently move the document and its pictures

TheEmbed picture in documentandEmbed all ~ around - e.g. from disc to disc. Alternatively if
pictures in documentbuttons load the current ~ You drag and drop a folder in to the icon or
referenced picture or all referenced pictures in thdrowse for a folder, the absolute path of the
document - effectively these buttons scrap the ~ destination directory will be used.

references. You might use them if you wanted to In general the collection option allows you to
prepare the document for passing on to someonechange all the reference paths in a document,

else and the pictures are not too large. providing they are valid to start with. For example
The paths are subject to the usDahtion Pro you might change all the references from absolute
macro expansion. So text{rbraces} will be to position independent.

expanded. A common example is
{filedir}\picture.bnp

This expands to a file called ‘picture.bomp’ in the
directory containing the document. The point is
that as long as the picture is in the same directory
as the document this reference will work, so you
can move the document and picture without
having to change the references. The form
common in HTML files also works

\picture. bnmp
¥ Picture reference |
— This picture
Path | *E|
Embed picture in document | Referance picture |
—All pictures
Path {filedirhPFictures *ﬁl
Embed all pictures in document Collect referenced pictures |
Cancel | 0] 4

Fig, 10.26 - Picture reference window
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Proxy...
Menur>Picture=>Proxy...

CHapTER 10

There is a button on the main menu
View=>Options window (fig. 10.28).

SelectingProxy... will open a dialogue box

allowing the proxy picture to be controlled

(fig. 10.27).

Menuc>Viewr>Optionse...... Ctrl+Shift+O

WhenUse proxiesis ticked proxy pictures will be
used for on screen display in the current window.

The top section is the usual way of selecting the You'd probably untick this if you wanted to check
size of a proxy picture. The two icons underneathif the document displayed correctly with the real
this display the size of the picture and the currentPICtures, prior to printing It.
proxy picture (if there is onellake proxy

picture will create a new proxy picture using the
chosen settingfkemove proxy pictureremoves
the proxy, and finalllRemove all proxy pictures
removes all proxy pictures from the current

document.

pProxypictwre ______________HE|

—Size — Colour Depth
" Bage/8 1 Base T 4bpp O 1B bpp

= Base/2 1 Base™

& Bazsefd  Base™ @ Bhop 32 hpp

¥ Dithering

Current proxy sizel a Ficture sizel BBl

Remove proxy picture | Femove all proxy pictures |

Cancel |

Make proxy picture

Fig, 10.27 - The Proxy window

¥ view options |

W Toolbox W Pictures

I Buttan bar ™ Guidelines
¥ Info palette [T Print margins
[ Rulers [ Facing pages
[ Pasteboard I~ Invisibles

[ Spelling errors v Use proxies

Apply Cancel 0]4

Fig, 10.28 - The View Options window
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10.11 Setting Picture Choices proxies for vector files of quite modest size. You
MenuMisceChoicesPictures can also set the default parameters for creating

_ ] ] _ proxy picture by clicking on the menu icon to the
Some large picture handling options can be set irg,, right of Proxy if over.

the Picture Choices window (fig. 10.29).

ThePicture cacheis an area of memory which is
used for holding referenced pictures whilst they
are needed e.g. when printing. This memory is
shared between all documents.

You can uséicture choicesto set the maximum
size for the cache. Note that an attempt will be
made to load any picture, no matter how big.
Typically the picture cache maximum size
controls how many pictures will be held in
memory at any one time. As the picture cache
becomes full, pictures will be removed from it to
make space for new pictures.

Below this choice, there are two features which
work in a similar wayReference if overallows
you to tellOvation Pro to automatically reference
a picture on loading if it is over a given size.

Proxy if over automatically creates a proxy
picture if the original is over a given size. Note
that this assumes the raw file size is a reliable
indication of the size of the picture. Usually it will
be, but for example you might want to create

¥ Application choices |
e 1= I Ficture choices
( " Picture frame inget | Omm
Frint
Runaround errar 2
E:’ Picture import with Ctrl| 100 %
Seneral

[T Centre lock ™ Aspect lock

g& ™ Auto scale

¥ Check for missing fonts

— Picture cache max size | 200 Ll;l
. — [T Reference if over 200k ;I;I
'f/ ™ Proxy if aver 200k LILI *’El
Picture ll
Save Cancel | )78

Fig. 10.29 - The Picture Choices window
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10.12 Referenced Pictures and To create a document for displaying sheets of clip

Mail Merge art.

Normally mail merge is a way of customising
documents with text. Typically you may have a (b) Hold down shift and load a picture from disc

(a) Create a page design with a number of frames.

comma separated value (CSV) file from a into each frame, selecting the reference button.
database with the names and addresses of the The picture should be some sort of ‘default’. Also
people you want to send a standard lettésde notice that you have to do this once for each

12.5). Referenced pictures allow the possibility of frame, you can’t just copy the picture and you
adding pictures to documents under the control otan’t copy the frame with the picture in it. This is
a CSV file. So not only can you address your so that you get a separate picture within

letter to Mr. Jones, you can also include his Ovation Pro in each frame.

picture in it. Some possible applications; (c) Now for each picture on the page except the

(1) Producing identity cards. Given a standard last one, open theeference...window
card layout and a database of names and

X Menuc>Picturec>Reference...
pictures.

and change the path to something like:
(2) Producing catalogue sheets of clip art. A _ g P _ 9
{macv=field(1); if(mcv=="")

simple program will produce a list of all the — C\ Pi ot \ hi el
picture files in a given directory as a CSV file. racy=" . tHcruresigraphi c.em=, el se
nextrecord()}

You can then have a document which displays
a number of these pictures on each page. ~ This says see what the first field in the mail merge

CSV file is, if it is null then use the default name,

To set up for mail merge, load a referenced otherwise use the field as the reference for the

fgcé?;glla;ygslczlgye?gjtrsvlgglnn?1ottorzzﬁ?naer%l;:r:;_re picture and then move to the next record in the

Select the picture box and open Reference... CSViile.
window. The last picture on the page should have a

. reference path like;
Menuc>Picturec>Reference... P

i {macv=field(1); if(macv=="")
The correct sort of text to enter is as follows; macv="C: \ Pi ct ur es\ gr aphi c. enf"; }
{macv=fiel d(1); if(macv=="")

d) Create a CSV file of your pictures. One eas
macv="C: \ Pi ctures\ pi cture. bnp";} () y P y

way to do this is using the ListDir application.

This can be found in the Extras.ListDir directory.
Roughly translated the path for the picture is take

from the first field in the current CSV file record
(i.e. field(1)), if that is the null string (which is the For general information on mailmergisee 12.5.
value when there is no mail merging going on)

then the path is the given string (C:\ etc.), a good

choice for this latter is the path to the original

referenced picture.

(‘e) Mail merge in the normal way.

All the tricks you can use with mail merge fields
are also possible with the contents of the reference
path. For example you could add code to scan the
contents of a directory for pictures. Or supply a
picture depending on the contents of other fields
e.g. a smiley picture for those with more than £0

in their account and a frown for those with less
than £0.
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10.13 Snags, Hints and Tips

1. If you use large picture features the resulting
Ovation Pro document may not work with older
versions ofOvation Pro.

2. There is considerable scope for ending up with
a referenced picture where the reference points at
a non-existent file. Typically this will generate an
error when redrawing the page. The problem then
is how to get at the window that will let you

change the reference path for the picture. What
you need to do is use the main menu and open the
View options window and deselect ‘Pictures’.

You can then safely expand the window and
change the reference.

3. If you save a document as DDL or a Stylesheet
then when it is reloaded the file name is lost. This
precludes the use of relative paths.

4. If a referenced picture has a document relative
path and you copy it to another document the path
will be converted to an absolute one.

5. The paths to referenced pictures are stored in
documents. These paths have different forms on
different operating systems. An effort has been
made to make the Windows version of

Ovation Pro able to understand RISC OS paths.
Unless different machines are sharing files on a
common file system, usually only document
relative paths will be transferable between
computers.

6. Pictures loaded via filters, that is pictures in file
formats whichOvation Pro does not support
directly for example .gif can be referenced in the
Windows version oOvation Pro however note

that this is not the case for the RISC OS version.

7. Often you may have a document where many
picture frames contain the same picture.
Obviously it would be wasteful if the document
contained one copy of the picture for each frame,
Ovation Pro makes every effort to only have one
copy of the picture in the document.

Snacs, Hints & Tips
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Notes:



